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Verwendungszweck 
 

 
Verwendungszweck 

 

ClinicalExpress ist für die Weiterleitung eines DICOM-Bildes von einem 
medizinischen Bilddigitalisierer an einen DICOM-Druckklassenprovider oder einen 
Speicherklassenprovider bestimmt. Die Zielgruppe besteht aus Benutzern, die einen 
medizinischen Filmdigitalisierer verwenden möchten, um analoge oder durchlässige 
Filme mithilfe eines herkömmlichen Teleradiologie-Ansatzes an eine DICOM- 
Workstation zu scannen, sowie Benutzern, die Filmausdrucke mithilfe von 
Digitaltechnologie in DICOM- und Postscript-Protokollen duplizieren möchten. 

 
Bestimmter Benutzer 

 
Die Zielbenutzer dieser Geräte sind medizinisches Fachpersonal oder geschultes Personal 
zur Verwendung als sekundäre Aufnahmebilder zur Konsultation, Überprüfung und 
endgültigen Interpretation. 
 
Es gibt keine Schulungspflicht für den Benutzer. Der Benutzer sollte mit dem Umgang 
mit Röntgenfilmen und der Verwendung von Bürogeräten wie einem PC vertraut sein. 
Der Benutzer sollte die Bedienungsanleitung lesen, um zu verstehen, wie Filme in den 
Filmdigitalisierer geladen werden. Der Benutzer muss mit der auf dem PC verwendeten 
Software vertraut sein, um das gescannte Bild zu erfassen. 

 
Hinweis für den Benutzer 

 
Es gibt keine Warnungen oder Vorsichtsmaßnahmen. Das Gerät ist nicht geduldiger 
Kontakt. Es sind keine Kontraindikationen oder Vorsichtsmaßnahmen erforderlich.  
 

 
Im Falle eines schwerwiegenden Vorfalls im Zusammenhang mit dem Gerät melden Sie 
dies bitte dem Hersteller und der zuständigen Behörde des Mitgliedstaats, in dem der 
Benutzer und / oder Patient ansässig ist. 
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Sincherheit, Leistung, Lagerung 
und Hand 

 
 

 
Sincherheit und Leistung 

 
• Da es sich um ein Softwareprogramm handelt, das auf einem Windows-Host-PC 
installiert ist, gibt es keine Sicherheitsprobleme mit dem Produkt. Die Leistung des 
Produkts wird durch die Ausgabe des Geräts gesteuert, das die Daten bereitstellt, sowie 
durch die Schulung und das Wissen des Benutzers.  
 
• Es wird erwartet, dass der Benutzer die Bilder mithilfe der Tools in der Software 
auswerten und anpassen kann, um die Bildqualität zu maximieren, bevor sie an PACS 
gesendet werden. 

 
Lagerung und Handhabung 
 
• Fassen Sie die Scheiben an der Außenkante oder am Mittelloch an. 
• Halten Sie Schmutz oder andere Fremdkörper von der Disc fern. 
• Bewahren Sie die Discs aufrecht (im Buchstil) in Plastikhüllen auf, die mit der CD 
geliefert wurden 
• Legen Sie die Discs sofort nach Gebrauch in die Aufbewahrungsboxen zurück. 
 
• Die ClinicalExpress-Software-CD sollte von der für die Software-Workstation 
verantwortlichen Person an einem sicheren Ort aufbewahrt werden. Die CD wird 
benötigt, wenn der PC jemals ausgetauscht wird oder wenn ein Fehler mit der Festplatte 
des PCs auftritt. 
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Über dieses Handbuch 

 

 
 
Dieses Handbuch enthält schrittweise Anweisungen für die Installation und 
Verwendung von ClinicalExpress®. Das Handbuch ist in die folgenden Themen 
untergliedert: 
 
 Über ClinicalExpress beschreibt ClinicalExpress als Teil eines typischen 

DICOM-Radiographie- oder Mammographiesystems. 
 
 Installieren von ClinicalExpress erläutert die Systemanforderungen und 

enthält Anweisungen zum Installieren der Software. 
 

Hinweis: Verbindungsinformationen entnehmen Sie bitte dem 
separaten Dokument DICOM-Konformitätserklärung (DICOM 
Conformance Statement). 

 
 Konfigurieren von ClinicalExpress demonstriert das Konfigurieren des 

ClinicalExpress-Systems zur Filmaufzeichnung- und -übertragung und 
erläutert andere Themen, die für Verwalter von ClinicalExpress-Systemen 
von Interesse sein könnten. 

 
Hinweis: Die Bedienungsanleitung ist in einem separaten 
Handbuch, dem ClinicalExpress-Bedienungshandbuch, enthalten. 

 
 
 

In diesem Handbuch verwendete Konventionen 
 
 Spezielle Tasten, die Sie auf der Tastatur drücken, werden in KAPITÄLCHEN 

dargestellt. Beispiel: Wenn Sie das Wort EINGABE im Text lesen, drücken Sie 
auf die entsprechende Taste auf Ihrer Tastatur. 

 
 Menünamen und Menübefehle erscheinen in Blockbuchstaben. Beispiel: 

Das Menü Datei (File) enthält den Befehl Lizenz installieren (Install License). 
Befehle werden in diesem Handbuch als Kürzel ausgedrückt. Beispiel: Datei > 
Beenden (File > Exit) bedeutet: Wählen Sie den Befehl Beenden (Exit) im 
Menü Datei (File). 
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 Fenster, Schaltflächen, Dialogfelder und andere Bildschirmfunktionen werden in 
Fettschrift gekennzeichnet. Beispiel: Das Fenster ClinicalExpress-Anmeldung 
(ClinicalExpress Login) (unten) enthält die Felder Benutzername (User Name) 
und Passwort (Password) sowie die Schaltflächen OK und Abbrechen (Cancel). 
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Über ClinicalExpress®
 

 

 
 
 
ClinicalExpress 6.0 ist ein Windows-basiertes Programm, das Filme digitalisiert und 
Filmbilder überträgt. Das Programm enthält die Modi „Allgemeine Radiographie“ 
(General Radiography) und „Mammographie“ (Mammography) und kann nur für 
den Modus „Allgemeine Radiographie“, nur für den Modus „Mammographie“ oder 
für beide Modi erworben werden. 
 
Digitalisierung. ClinicalExpress zeigt mithilfe eines VIDAR-Filmdigitalisierers als 
Eingabegerät Filmbilder an und weist sie einem Patienten und einer Untersuchung 
zu. Das Programm enthält eine Reihe von Funktionen zur Überprüfung der Qualität 
eines Bildes und zum Anpassen seiner Eigenschaften. 
 
Indikationen. Radiologiebilder, die mit ClinicalExpress digitalisiert wurden, erfüllen 
oder übertreffen die ACR- und DICOM-Standards für die Verwendung sekundärer 
Bilder zur Konsultation, Überprüfung und endgültigen Auswertung. 

 
Mammographiebilder, die mit ClinicalExpress als DICOM MG digitalisiert wurden, 
dienen lediglich der Verwendung zu Referenz- oder Vergleichszwecken und sind 
nicht für die primäre Diagnosestellung bestimmt. 
 
 
 
Optionen 
 
Die folgenden Optionen können separat erworben werden: 
 
Modalität-Arbeitsliste (Modality Work List). Mit dieser Option können 
Bildmodalitäten Arbeitslisteninformationen über geplante Verfahren und relevante 
Daten herunterladen und diese Informationen dem Modalitäts-Operator vorlegen 
und sicherstellen, dass DICOM-Bilder übereinstimmende, deskriptive Daten 
enthalten. Anleitungen zur Verwendung der Modalität-Arbeitsliste in ClinicalExpress 
sind in diesem Handbuch zu finden. Integrationsdetails sind in der DICOM-
Konformitätserklärung (DICOM Conformance Statement) zu finden. 
 
PDI. Diese Option enthält Funktionen für das Importieren/Exportieren von 
DICOM-Medien (zum Lesen und Beschreiben von DICOM-CDs), das Flachbett-
Scannen und die Patientenabfrage (zum Suchen nach Patienteninformationen auf 
Speichergeräten). 
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Systemübersicht 
 
Eine typische ClinicalExpress-Workstation für die Filmaufzeichnung und  
-übertragung besteht aus den folgenden Komponenten: 
 
 VIDAR-Filmdigitalisierer für die Erstellung von Digitalbildern von Filmen. 
 
 Windows® XP 32-Bit- oder Windows 7 32- oder 64-Bit-Computer, auf 

dem das ClinicalExpress-Programm ausgeführt wird. 
 
 

Hinweise 

 Die ClinicalExpress-Workstation ist KEINE diagnostische 
Workstation. Für diagnostische Aufgaben verwenden Sie 
bitte eine entsprechende Workstation (für Anweisungen 
siehe das Installations- und Bedienungshandbuch der 
diagnostischen Workstation). 

 Mammographiebilder, die mit ClinicalExpress digitalisiert 
wurden, dienen lediglich der Verwendung zu Referenz- 
oder Vergleichszwecken und sind nicht für die primäre 
Diagnosestellung bestimmt. 
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Allgemeiner Radiographie-Modus (General Radiography Mode) 
 
Für die Bildübertragung gibt die Workstation Bilddaten an eine Datenverbindung 
aus, die diese an eine Remote-Workstation oder ein Remote-System liefert. Zum 
Kopieren stellt die Workstation eine Verbindung mit einem Filmdrucker oder Nicht-
Film-Ausgabegerät her. Ein optionaler Dokumentscanner kann als zusätzliches 
Eingabegerät fungieren. 
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Mammographie-Modus (Mammography Mode) 
 
Für die Bildübertragung gibt die Workstation Bilddaten an eine Datenverbindung 
aus, die diese an eine Remote-Workstation oder ein Remote-System liefert. 
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Was können Sie mit ClinicalExpress erledigen? 
 
ClinicalExpress 6.0 ist Ihre primäre Steuerstelle für die Aufzeichnung, Übertragung 
und das Kopieren von Filmen. Sie können mit dem Programm die folgenden 
Aufgaben erledigen: 

 Digitalisieren 
 Designieren eines Patienten und einer Untersuchung oder Erstellen eines 

neuen Patientendatensatzes und/oder einer neuen Untersuchung. 
 Verwenden der Option „Modalität-Arbeitsliste“ (Modality Work List) 

(separat erhältlich), um Patienteninformationen aus einer externen Quelle 
heranzuziehen (anstatt Patientendaten einzutippen). 

 Grundlegende Digitalisierungsparameter einstellen: Bit-Tiefe und Auflösung. 
 Einen oder mehrere Filme digitalisieren. 
 Die Qualität des Bildes überprüfen, das anhand des Films erstellt wurde, 

bevor es gesendet oder kopiert wird. 
 Das Bild bearbeiten: Fenster und Ebene festlegen, drehen, umkehren, 

Tonwerte invertieren, Bild unterteilen, einen Betrachtungsbereich 
vergrößern, zoomen und vertrauliche Informationen maskieren. 

 Übertragen 
 Eine Remote-Workstation oder ein Remote-System („Ziel“) auswählen. 
 Digitalisierte Bilder an das ausgewählte Ziel senden. 
 In einem Vorgang digitalisieren und senden. 

 Kopieren (nur Allgemeiner Radiographie-Modus) 
 Einen Drucker auswählen (wenn mehrere Drucker mit dem System 

verbunden sind). 
 Anzahl Kopien einstellen, die von jedem Film-Original angefertigt werden 

sollen. 
 Druck initiieren. 
 Mehrere Bilder auf einem Film kombinieren. 
 In einem Vorgang digitalisieren und drucken. 

 Von und zu DICOM-Standard-CDs importieren bzw. exportieren. 
 
ClinicalExpress wird auf Feature-/Funktionsbasis lizenziert. Alle Lizenzen 
enthalten die Digitalisierungsfunktion sowie die Funktion „DICOM senden“ 
(Senden an DICOM-Serviceklassen-Provider, Workstations/PACS) und 
„Kopieren“ (Drucken auf DICOM-Druckern und/oder Postscript-Geräten). 
Außerdem können Sie folgende Lizenzen erwerben: 

 Modalität-Arbeitsliste (Modality Work List). 

 PDI. CD-Brennen vom DICOM-Viewer zu Medienexport, Medienimport/-
export, Patientenabfrage und Papierdokument-Scanner. 
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Neue Funktionen in ClinicalExpress 6.1 
 
 Neue Datumsformat-Optionen. 
 DICOM-Support für Mammographie-abgeleitete/primäre Tags für 

Kompatibilität mit GE-Systemen. 
 Support für Mammographie-Datumserfassung für Kompatibilität mit 

Siemens-Systemen. 
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Installieren von ClinicalExpress®
 

 

 
 
 

Systemanforderungen 
 
Zum Digitalisieren und Übertragen von Bildern mit ClinicalExpress® benötigen 
Sie ein Computersystem, einen VIDAR-Filmdigitalisierer und eine 
Netzwerkverbindung. 
 
 
Computer 
 
Mindestanforderungen an das Computersystem für Windows XP 32-Bit SP3: 
 3,0 GHz Pentium 4 PC 
 2 GB Speicher; für große Sätze mit hochauflösenden Bildern wie 

Mammographie ist mehr Speicher erforderlich 
 50 GB freier Speicherplatz auf der Festplatte 
 
Mindestanforderungen an das Computersystem für Windows 7 Professional  
32-Bit und 64-Bit: 
 Dual Core 2 1,8 GHz PC 
 4 GB Speicher; für große Sätze mit hochauflösenden Bildern wie 

Mammographie ist mehr Speicher erforderlich 
 50 GB freier Speicherplatz auf der Festplatte 
 
Grafik für alle Computer: 
 Grafikkarte mit 16 MB Speicher, eingestellt auf eine Auflösung von 

1280x1024 und 64.000 Farben oder höhere Farbtiefe 
 20-Zoll-Bildschirm mit einer Auflösung von 1280x1024 
 
 
Filmdigitalisierer 
 
ClinicalExpress funktioniert mit den meisten VIDAR-Digitalisierern für 
medizinische Filme. Wenden Sie sich an Medtech (medtech@3dsystems.com), 
um in Erfahrung zu bringen, ob Ihr Digitalisierer kompatibel ist. 
 
ClinicalExpress funktioniert nicht mit Filmdigitalisierern anderer Hersteller. 
 
 
Netzwerkverbindung 
 
Geeignete Netzwerkverbindungen sind u. a. LAN, WAN, drahtlos und eine Reihe 
von telefonbasierten Services. Für den ordnungsgemäßen Betrieb ist TCP/IP 
erforderlich. Netzwerkverbindungsdetails sind nicht in diesem Handbuch enthalten. 
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Optionaler Dokumentscanner 
 
Sie können einen USB-Dokumentscanner zu Ihrem System hinzufügen. 
ClinicalExpress funktioniert mit den meisten TWAIN-Treiber. Die Möglichkeit der 
Verwendung eines Dokumentscanners ist eine käufliche Option. Eine Liste der 
getesteten Scanner erhalten Sie vom technischen Support von VIDAR (siehe unten). 
 
 

Installationsszenarien 
 
Lesen Sie die Szenarien unten, um Ihren aktuellen Status zu bestimmen und zu 
entscheiden, wie Sie die ClinicalExpress 6.0-Installation durchführen werden. 
 
 
 Wenn Sie ClinicalExpress zum ersten Mal installieren: 

1. Führen Sie die Datei ClinicalExpress6.x..exe auf der ClinicalExpress CD aus. 

2. Die Software kann 30 Tage lang in einem Evaluierungsmodus verwendet 
werden. Um die Software nach Ablauf der 30 Tage weiterhin zu benutzen, 
benötigen Sie einen Lizenzschlüssel (siehe „Einen ClinicalExpress-
Lizenzschlüssel anfordern“ später in diesem Kapitel). 

 
 
 Wenn eine frühere Version von ClinicalExpress installiert ist: 

 Bei installierten Versionen 4.x und früher wenden Sie sich für Upgrade-
Anweisungen bitte an den technischen Support von VIDAR (siehe unten). 

 Bei installierten Versionen 5.0 und später können Sie ClinicalExpress 6.0 
installieren, ohne die vorhergehende Version deinstallieren zu müssen. 

 
 
 

Bei Fragen über die Installation der ClinicalExpress-Software 
wenden Sie sich bitte an den technischen Support von VIDAR: 

Telefon: +1.800.471.SCAN (+1.800.471.7226) 

 +1.703.471.7070 außerhalb der USA 

E-Mail: medtech@3dsystems.com 
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Installationsübersicht 

 
Hinweis: Sie müssen als Administrator angemeldet sein, 
um ClinicalExpress installieren und administrative Funktionen 
durchführen zu können. Benutzer können, aber müssen nicht, 
administrative Rechte auf dem PC.Für Anweisungen siehe: 
 Thema „Hinzufügen eines Mitglieds zu einer Gruppe“ (To add 

a member to a group) in der Windows XP Hilfe und im Support 
Center. 

 Themen „Erstellen eines neuen Benutzerkontos“ (Create a 
new user account) und „Modifizieren eines Benutzerkontos“ 
(Modify a user account) in der Hilfedatei für das Fenster 
„Windows Computer Management“. 

 
Die Installation besteht aus fünf allgemeinen Schritten: 

A. Den Filmdigitalisierer installieren und konfigurieren. 

B. Die Anzeige einstellen. 

C. Die ClinicalExpress-Software installieren. 

D. ClinicalExpress starten. 

E. ClinicalExpress-Lizenzschlüssel anfordern. 

 
Einzelheiten sind in den nachfolgenden Abschnitten zu finden. 
 

Tipp: Wenn Sie eine neue Workstation einrichten, installieren Sie 
nicht alle Komponenten gleichzeitig. Installieren Sie zuerst den 
Filmdigitalisierer (gemäß Anleitung, die mit dem Digitalisierer 
geliefert wurde). Richten Sie als nächstes die Anzeige ein (Schritt 
B). Installieren Sie zum Schluss die ClinicalExpress-Software 
(Schritt C) und stellen Sie sicher, dass das System funktioniert. 

 
 
 

A. Den Filmdigitalisierer installieren und konfigurieren 
 
Installieren und konfigurieren Sie den Filmdigitalisierer und dessen Software 
gemäß Anleitung, die mit dem Digitalisierer geliefert wurde (Details sind in 
diesem Handbuch nicht enthalten). 
 
 

Hinweis: Sie können die Installations- und Betriebshandbücher 
für den VIDAR-Filmdigitalisierer im Kundendienstbereich auf 
www.filmdigitizer.com herunterladen. Sie können auch die 
Nummer +1.800.471.7226 (+1.703.471.7070 außerhalb der USA) 
anrufen, um Handbücher anzufordern. 
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B. Die Anzeige einstellen 
 
1. Klicken Sie mit der rechten Maustaste auf dem Desktop, und klicken Sie dann 

im Popup-Menü auf Eigenschaften (Properties). 
 

  
 

Hinweis: Der Befehl Eigenschaften (Properties) kann auf Ihrem 
System durch einen Anzeigeadapter-spezifischen Befehl ersetzt 
sein. Klicken Sie in diesem Fall auf den Befehl. Das Dialogfeld 
mit den Anzeigeeigenschaften kann anders aussehen, aber das 
Ziel ist gleich, Einstellen der Anzeigeauflösung auf 1280x1024 
oder höher und Einstellen der Farbtiefe auf 16-Bit oder höher 

 
2. Klicken Sie im Fenster Anzeigeeigenschaften (Display Properties) auf die 

Registerkarte Einstellungen (Settings). 
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3. Setzen Sie Bildschirmbereich (Screen Area) oder Bildschirmauflösung (Screen 
Resolution) auf 1280x1024 oder höher, und setzen Sie Farben (Colors) oder 
Farbqualität (Color Quality) auf Hohe Farbe (16 bit) (High Color (16 Bit) oder 
höher. 

 

  
 
4. Klicken Sie auf OK. 
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C. Die ClinicalExpress-Software installieren 
 

Hinweis: Wenn Sie von ClinicalExpress 4.x oder einer früheren 
Version aus aktualisieren, bitten Sie den technischen Support von 
VIDAR (medtech@3dsystems.com) um entsprechende 
Anweisungen. 

 
Hinweis: Sie können ClinicalExpress ohne den Filmdigitalisierer 
im System installieren. ClinicalExpress funktioniert jedoch nur 
dann, wenn der Filmdigitalisierer am Computer angeschlossen 
und eingeschaltet ist und mit dem Computer kommuniziert. 

 

1. Legen Sie die ClinicalExpress-CD in das CD-Laufwerk des Computers ein. 
 
2. Navigieren Sie in Windows Explorer zum CD-Laufwerk und doppelklicken 

Sie auf ClinicalExpress6.x..exe. 
 
3. Befolgen Sie die Anweisungen des Installationsprogramms. 
 
 Während der Installation werden Sie aufgefordert, die Standard-GUI – 

Allgemeine Radiographie oder Mammographie – auszuwählen, die beim 
Starten von ClinicalExpress angezeigt wird. Wählen Sie die GUI, die am 
besten für Ihre Situation geeignet ist (diese Option kann auf der Seite 
Administration > Lokal (Administration > Local) von ClinicalExpress 
geändert werden). 

 
4. Nachdem die Installation abgeschlossen ist, nehmen Sie die CD-ROM aus 

dem CD-ROM-Laufwerk. (In Schritt E benötigen Sie den CD-Schlüssel vom 
CD-Etikett.) 

 
 
 
 

Hinzufügen eines Flachbett-Papierscanners 
 
Sie können einen Flachbett-Scanner für die Verwendung mit ClinicalExpress 
installieren. Befolgen Sie die Installationsanweisungen des Scanner-Herstellers. 
VIDAR hat typische USB 2.0-Scanner mit TWAIN-Treibern getestet und ihre 
Kompatibilität mit ClinicalExpress bestätigt. 
 

Hinweis: Auf der ClinicalExpress-Workstation sollte nur der 
TWAIN-Treiber des Flachbett-Scanners installiert werden. Alle 
anderen TWAIN-Treiber können den Betrieb von ClinicalExpress 
stören. Eine Liste der getesteten Scanner erhalten Sie vom 
technischen Support von VIDAR (medtech@3dsystems.com). 
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D. ClinicalExpress starten 
 

Hinweis: ClinicalExpress funktioniert 30 Tage lang ohne 
Lizenzschlüssel. Um ClinicalExpress nach diesem Zeitraum 
weiterhin zu verwenden, wenden Sie sich an die VIDAR 
Systems Corporation, um einen Lizenzschlüssel anzufordern 
(Anweisungen sind dem nächsten Abschnitt zu entnehmen). 

 
1. Doppelklicken Sie auf das ClinicalExpress-Symbol auf dem Desktop.  
  oder 
 Start > Alle Programme > ClinicalExpress (Start > All Programs >  

ClinicalExpress). 
 
2. Das Fenster Benutzeranmeldung (User Login) erscheint: 
 

  
 
3. Verwenden Sie den/das Standard-Administrator-Namen/-Passwort 

a. Belassen Sie den Benutzernamen (User Name) als Admin. 
b. Lassen Sie das Feld Passwort (Password) leer. 
c. Klicken Sie auf OK. 

 
4. Wenn der Digitalisierer eingeschaltet und korrekt angeschlossen ist, erscheint 

die nachfolgende Meldung. Klicken Sie auf OK. 
 

  
 
5. ClinicalExpress wird gestartet. 
 

Hinweis: Sie können erst dann Filme digitalisieren, wenn Sie 
mindestens ein gültiges Ziel definiert haben. Siehe das nächste 
Kapitel „Konfigurieren von ClinicalExpress“ in diesem Handbuch. 
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E. ClinicalExpress-Lizenzschlüssel anfordern 
 

Hinweis: Um einen Lizenzschlüssel zu erhalten, reicht es nicht 
aus, die ClinicalExpress-Lizenzvereinbarung per Fax einzusenden. 
Sie müssen den Anweisungen in diesem Abschnitt folgen, um den 
Lizenzschlüssel per E-Mail anzufordern. 

 
So erhalten Sie einen Lizenzschlüssel: 
 
1. Senden Sie die Referenzcode-Datei an VIDAR: 
 

Hinweis: Sie können nur dann einen Referenzcode generieren, 
wenn der ClinicalExpress-Computer an einen VIDAR-
Filmdigitalisierer angeschlossen ist. 

 
a. Gehen Sie im ClinicalExpress-Hauptfenster zu Datei > Referenzcode 

generieren (File > Generate Reference Code). 
 
b. Im Dialogfeld Referenzcode generieren (Generate Reference Code): 
 Geben Sie die Informationen für Benutzername (User Name), 

Firma (Company) und Land (Country) ein bzw. ändern Sie diese 
Informationen. 

 Geben Sie den CD-Schlüssel vom Etikett der ClinicalExpress-
Installations-CD ein. 
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c. Klicken Sie auf die Schaltfläche Referenzcode generieren (Generate 
Reference Code). 

 

  
 

Hinweis: Der Referenzcode ist 15 Tage lang gültig. 

 
d. Klicken sie auf Speichern (Save), um den Referenzcode als Datei auf der 

lokalen Festplatte zu speichern. Speichern Sie die Datei an einer Stelle, den 
Sie sich leicht merken können. 

 
e. Klicken Sie auf die Schaltfläche Schließen (Close). 
 
f. Starten Sie eine neue E-Mail-Nachricht. 
 
g. Geben Sie im Adressfeld medtech@3dsystems.com ein. 
 
h. Anschließend: 
 
 Suchen Sie die Datei (sie weist die Dateinamenserweiterung .ref auf), 

die Sie in Schritt D oben gespeichert haben, und fügen Sie sie an die 
Nachricht an. 

 
i. Senden Sie die Nachricht. 
 

Hinweis: Während Sie auf Ihren Lizenzschlüssel warten, 
können Sie ClinicalExpress bis zu 30 Tage lang ohne Schlüssel 
im Evaluierungsmodus verwenden. Im Evaluierungsmodus 
stehen alle Funktionen zur Verfügung. 
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2. Nachdem Sie Ihren Lizenzschlüssel per E-Mail von VIDAR erhalten haben: 
 

a. Speichern Sie die Anlage (mit der Erweiterung .key) auf dem Desktop. 
 
b. Melden Sie sich als Administrator bei ClinicalExpress an. 
 
c. Gehen Sie im ClinicalExpress-Hauptfenster zu Datei > Lizenz installieren 

(File > Install License). 
 

  
 
d. Im Dialogfeld Lizenz installieren (Install License): 
 
 Klicken Sie auf die Schaltfläche Von Datei laden (Load From File), 

und öffnen Sie die Lizenzschlüssel-Datei (mit der Erweiterung .key). 
 

  
 
e. Klicken Sie auf die Schaltfläche Registrieren (Register). 
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f. Wenn der Lizenzschlüssel akzeptiert wird, erscheint das unten dargestellte 
Fenster. Klicken Sie auf OK. 

 

  
 
g. Datei > Beenden (File > Exit). 
 
h. Starten Sie ClinicalExpress erneut, indem Sie auf dem ClinicalExpress-

Symbol auf dem Desktop doppelklicken. 
 
i. Zur Überprüfung Ihrer Lizenz gehen Sie zu: Hilfe > Über (Help > About). 

Ihre Lizenz erscheint oben auf der Seite. Wenn Sie Lizenzen für Allgemeine 
Radiographie und Mammographie besitzen, sollten Sie die Lizenz in beiden 
Anwendungen überprüfen. 

 
3. Zum Konfigurieren des Programms siehe das nächste Kapitel „Konfigurieren 

von ClinicalExpress“ in diesem Handbuch. 
  oder 
 Wenn Sie ClinicalExpress zum Drucken konfigurieren müssen, lesen Sie bitte 

die Anweisungen zum Einrichten von Druckern, die für die Verwendung mit 
ClinicalExpress validiert wurden, im Verzeichnis Druckerspezifisch (Printer 
Specific) auf der ClinicalExpress-Installations-CD. 
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Konfigurieren von 
ClinicalExpress®

 

 

 
 

Einführung 
 
Dieses Kapitel beschreibt die administrativen Aufgaben, die innerhalb von 
ClinicalExpress durchgeführt werden können. 

 Anmelden im Fenster Administration 

 Einstellen von Parametern auf der lokalen Workstation 

 Einstellen von Anzeigeparametern 

 Einstellen der Digitalisiererauflösung 

 Einstellen von Bildbearbeitungsoptionen 

 Definieren von Mammographie-Ansichten 

 Zuweisen obligatorischer Dateneingabefelder 

 Verwalten von Benutzerkonten 

 Auswählen von Datenfeldern für die Anonymisierung 

 Sichern und Wiederherstellen der Lizenz 

 Definieren von Zielen 

 Überprüfen der Konfiguration des Filmdigitalisierers 

 Überprüfen der Verfügbarkeit der „Modalität-Arbeitsliste“ (Modality Work List) 

 Überprüfen und Verwalten der Protokolldatei 

 Kalibrieren des Filmdigitalisierers 
 
Dieses Kapitel enthält außerdem grundlegende Anleitungen zum Kalibrieren 
eines Workstation-Bildschirms. 
 
Wenn Sie ClinicalExpress erstmalig einrichten, sollten Sie zunächst alle 
Abschnitte dieses Kapitels lesen und alle Aufgaben ausführen, die auf Ihre 
lizenzierten ClinicalExpress-Funktionen und die Systemkonfiguration zutreffen. 
 

Hinweis: Sie müssen als Administrator des lokalen Computers 
angemeldet sein, um das ClinicalExpress-Fenster Administration 
aufrufen und darin Änderungen vornehmen zu können. 

 
Hinweis: Sie können erst dann Filme digitalisieren, wenn Sie 
mindestens ein gültiges Ziel definiert haben. Siehe „Definieren 
von Zielen“ später in diesem Kapitel. 



 Konfigurieren von ClinicalExpress 27 

19746-001 Rev. E ClinicalExpress 6.1 Administratorhandbuch 

Anmelden im Fenster Administration 
 
Das ClinicalExpress-Fenster Administration ist passwortgeschützt. 
 
1. Optionen > Administration (Options > Administration). 
 
 Wenn Sie bereits als Administrator bei ClinicalExpress angemeldet sind, 

sehen Sie das Fenster Administration und können mit Schritt 2 fortfahren. 
Andernfalls sehen Sie das Anmeldefenster: 

 

  
 
2. Geben Sie das Administrator-Passwort ein und klicken Sie auf OK. 
 
 
 

Tipp: Der standardmäßige  
Name ist Admin (Groß- und 
Kleinschreibung beachten) und 
das Standardpasswort ist kein 
Passwort (d.h. lassen Sie das 
Feld Passwortt frei). 
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Einstellen von Parametern auf der lokalen Workstation 
 
Legen Sie Parameter für die lokale Workstation unter Lokal (Local) der 
Baumstruktur Administration fest. 
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DICOM-Parameter 
 

 
 
 
Der AE-Titel (Application Entity) ist der Name, den andere Software-Anwendungen 
benutzen, um diese Anwendung zu identifizieren. 
 
1. Geben Sie den AE-Titel für dieses DICOM-Gerät ein (standardmäßig wird 

„ClinicalExpress“ in dieses Feld eingegeben). Bei der Eingabe des AE-Titels 
ist die Groß-/Kleinschreibung zu beachten. 

 
2. Geben Sie die Port-Nummer (Port Number) für dieses DICOM-Gerät ein 

(standardmäßig wird „207“ in dieses Feld eingegeben). 
 
3. Klicken Sie auf die Schaltfläche Anwenden (Apply). 
 
 
Protokoll 
 

 
 
 
1. So ändern Sie bei Bedarf die Protokolleinstellungen: 
 
 Protokollebene: Gibt die Arten der Informationen an, die im Fenster 

Fehlerprotokoll (Error Log) angezeigt werden können: 
 INFORMATIONEN (INFORMATION) zeigt DICOM-Informationen 

und ClinicalExpress-Informationen an. 
 WARNUNG (WARNING) zeigt nur Fehler und Warnhinweise an. 
 FEHLER (ERROR) zeigt nur Fehler an. 

 
 ClinicalExpress erfasst automatisch alle Fehler und Informationen. (Zum 

Anzeigen des gesamten Fehlerprotokolls öffnen Sie die Datei clx.log in 
einem Texteditor.) 

 
Hinweis: Das Fenster Fehlerprotokoll (Error Log) ist kein 
komplettes DICOM-Diagnose-Tool, da es keine vollständigen 
DICOM-Übertragungen erfasst. Es dient hauptsächlich zur 
Software-Fehlerbehebung. 
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 Protokolleinträge bewahren: Einträge in der Protokolldatei werden nach 
dieser Anzahl Tagen gelöscht. (Siehe „Überprüfen und Verwalten der 
Protokolldatei“ später in diesem Kapitel.) 

 
2. Klicken Sie auf die Schaltfläche Anwenden (Apply). 
 
 
Lokalisierung 
 

 
 
1. Wählen Sie die Sprache (Language), die in der Benutzeroberfläche der 

Anwendung verwendet werden soll. 
 
2. Wählen Sie das Datumsformat (Date Format), das in der Anwendung 

verwendet werden soll. 
 
3. Klicken Sie auf die Schaltfläche Apply (Anwenden). 
 
4 Beenden Sie ClinicalExpress und starten Sie die Anwendung neu, um die 

Änderungen zu übernehmen. 
 
 
System 
 

 
 
1. Ändern Sie bei Bedarf die Einstellungen (Standardeinstellungen sind oben 

dargestellt): 
 
 Mindestens erforderlicher Speicherplatz (Minimum Disk Space): Wenn der 

freie Festplattenspeicher unter diesen Wert sinkt, löscht ClinicalExpress 
automatisch Dateien, beginnend mit den ältesten Untersuchungen, die 
erfolgreich gesendet wurden. Wenn das Programm nicht genug Speicherplatz 
freimachen kann, um den Wert Mindestens erforderlicher Speicherplatz 
(Minimum Disk Space) zu erreichen, kann der Benutzer erst dann weitere 
Filme digitalisieren, wenn ausreichend Speicherplatz verfügbar ist. 
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 Maximale Filmlänge (Maximum Film Length): Dieser Wert ist 

normalerweise auf eine Filmlänge von 17 Zoll eingestellt, kann jedoch 
geändert werden, um längeren Filmen gerecht zu werden. 

 
Hinweis: Erhöhen Sie den Wert Maximale Filmlänge (Maximum 
Film Length) nur dann auf einen größeren Wert als 17 Zoll, wenn 
ein DIAGNOSTICPRO® Plus oder DIAGNOSTICPRO® Advantage 
Filmdigitalisierer angeschlossen ist. Informationen über das 
Digitalisieren von Filmen, die länger sind als 17 Zoll, finden Sie im 
entsprechenden Bedienungshandbuch für den Filmdigitalisierer. 

 

Hinweis: Das das System eine Routine mit automatischer 
Größenerkennung verwendet, um die Filmlänge zu bestimmen, 
können perforierte Filme möglicherweise nicht digitalisiert werden. 

 
 Übertragungsversuche (Transmission Retries): Legt fest, wie oft 

ClinicalExpress versucht, eine Untersuchung an ein Ziel zu senden. 
ClinicalExpress geht mit nicht erfolgreich übertragenen Untersuchungen 
wie folgt um: 
 Wenn sich andere Untersuchungen in der Übertragungswarteschlage 

befinden, wird eine nicht erfolgreich gesendete Untersuchung an 
das Ende der Warteschlange gestellt und unter Berücksichtigung der 
Übertragungswiederholungen und Wiederholungszeit (siehe unten) 
ein Versuch unternommen, die Untersuchung später zu senden. 

 Wenn sich keine anderen Untersuchungen in der Übertragungswarteschlage 
befinden, versucht ClinicalExpress unter Berücksichtigung der 
Übertragungswiederholungen und Wiederholungszeit (siehe unten) sofort, 
die Untersuchung erneut zu senden. 

 Wenn die Untersuchung nach einer bestimmten Anzahl 
Übertragungsversuche nicht gesendet werden kann, wird sie im Fenster 
Aufgenommene Untersuchungen (Acquired Studies) (Ansicht > 
Aufgenommene Untersuchungen) (View > Acquired Studies) 
aufgelistet, wo Sie die Übertragung manuell einleiten können. 

 Eine Untersuchung, die nicht gesendet werden konnte, behält so lange 
den Status „fehlgeschlagen“, bis sie erfolgreich gesendet wurde. 

 
 Wiederholungszeit (Retry Time): Legt fest, wie lange (in Minuten) 

ClinicalExpress wartet, bis eine Untersuchung an ein Ziel gesendet wird, 
wenn der vorherige Versuch fehlgeschlagen ist. 

 
 Listenstartfeld (Lists’ Start Field): Legt fest, ob Patientenname 

(Patient Name) oder ID die erste Spalte in der Liste „Aufgenommene 
Untersuchungen“ (Acquired Studies) und „Arbeitslistenverfahren“ 
(Work List Procedures) bildet. 

 
 Bildpfad (Images Path): Ändern Sie auf Wunsch das standardmäßige 

lokale Verzeichnis für die Bildspeicherung. Dies kann z. B. dann nützlich 
sein, wenn Sie Bilder auf einem Laufwerk oder einer Partition mit mehr 
Speicherplatz speichern möchten. Um den Pfad zu ändern, klicken Sie auf 
die Schaltfläche ... und wählen Sie einen neuen Pfad aus. 
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 Tastensperre (Lock Keys): Wenn diese Funktion aktiviert ist, deaktiviert 
ClinicalExpress Tasten (z. B. ALT-TAB), die es einem Benutzer erlauben 
würden, zwischen ClinicalExpress und anderen geöffneten Programmen 
hin und her zu wechseln. 

 
 Zusätzliche Patientenanamnese aktivieren (Enable Additional Patient’s 

History): Wenn diese Funktion aktiviert ist, zeigt ClinicalExpress das Feld 
Zusätzliche Patientenanamnese (Additional Patient History) unten im 
Fenster Untersuchungsinformationen (Study Information) an. 

 

  
Das Fenster Patienten-/Untersuchungs-/ 
Serieninformationen (Patient/Study/Series Information) ohne 
Zusätzliche Patientenanamnese (Additional Patient History) 

Das Fenster Patienten-/Untersuchungs-/ 
Serieninformationen (Patient/Study/Series Information) mit 
Zusätzliche Patientenanamnese (Additional Patient History) 

 

 Aufnahmenummer automatisch generieren (Auto Generate Accession 
Number): Wenn diese Funktion aktiviert ist, fügt ClinicalExpress 
automatisch die nächste sequenzielle Aufnahmenummer im Feld 
Untersuchungsinformationen (Study Information) ein, wenn der 
Benutzer eine neue Untersuchung initiiert. Die eingegebene 
Aufnahmenummer kann bearbeitet werden. 

 
 Aufnahmenummer leer senden (Send Empty Accession Number): 

Wenn diese Funktion aktiviert ist, sendet ClinicalExpress keine 
Aufnahmenummern an Ziele. 

 
 Filmgrößen-ID senden (Send Film Size ID): Wenn diese Funktion 

aktiviert ist, sendet ClinicalExpress Filmabmessungen an die Ziele. 
 
 Jedes Bild als Serie senden (Send each image as a Series): Wenn diese 

Funktion aktiviert ist, wird jedes Bild als Serie gesendet. Wenn diese 
Funktion deaktiviert ist, kann eine Serie aus mehreren Bildern bestehen. 

 
 Bildtyp als ABGELEITET/PRIMÄR festlegen (Set Image Type as 

DERIVED\PRIMARY): Wenn diese Funktion aktiviert ist, wird jedes Bild 
für die Verwendung in GE-Mammographiesystemen gekennzeichnet. 

 

2. Klicken Sie auf die Schaltfläche Anwenden (Apply). 
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Autom. Abmeldung (Auto Logout) 
 

 
 
Wenn diese Funktion aktiviert ist, wird ClinicalExpress automatisch geschlossen, 
wenn innerhalb einer festgelegten Zeit keine Benutzeraktivität (Tastatur oder 
Maus) festgestellt wird. 
 
Klicken Sie nach dem Ändern auf die Schaltfläche Anwenden (Apply). 
 
 
 
Nach dem Senden löschen (Delete After Send) 
 

 
 
Wenn diese Funktion aktiviert ist, löscht ClinicalExpress Patienten und/oder 
Bilder ca. 10 Minuten nach der erfolgreichen Übertragung an das Ziel. 
Überlegungen: 
 Wenn die Funktion aktiviert ist, wird verhindert, dass die Festplatte der 

Workstation bis zur Kapazität mit Bilddateien gefüllt wird. Untersuchungen, 
die direkt nach der Aufnahme gesendet und dann gelöscht werden, werden 
jedoch nicht im Fenster Aufgenommene Untersuchungen (Acquired 
Studies) aufgelistet und können daher nicht zu einem späteren Zeitpunkt an 
dieselben oder andere Ziele gesendet werden. 

 Wenn die Funktion deaktiviert ist, können Untersuchungen im Fenster 
Aufgenommene Untersuchungen (Acquired Studies) aufgelistet und zu 
einem späteren Zeitpunkt an andere Ziele gesendet werden. Jedoch werden 
sich die Untersuchungen auf der Festplatte der Workstation anhäufen und 
letztendlich deren Kapazität erschöpfen. 

 Die ClinicalExpress-Datenbank ist auf 10 GB begrenzt. Wenn dieses Limit 
erreicht ist, müssen Sie Bilder und Patienten löschen, um weiter Filme 
digitalisieren zu können. 

 
Klicken Sie nach dem Ändern auf die Schaltfläche Anwenden (Apply). 
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Nach der Speicherübernahme löschen (Delete After Storage 
Commitment) 
 

 
 
Wenn diese Funktion aktiviert ist, löscht ClinicalExpress Patienten und/oder 
Bilder erst nach Eingang einer Speicherübernahme-Meldung von einem Ziel. 
Die Meldung bestätigt, dass Patienten und/oder Bilder nicht nur vom Ziel 
empfangen, sondern auch gespeichert wurden. (Für weitere Informationen siehe 
„Nach dem Senden löschen“ (Delete After Send) oben.) 
 
Klicken Sie nach dem Ändern auf die Schaltfläche Anwenden (Apply). 
 
 
 
Standardmäßige Start-GUI 
 

 
 
Diese Option legt die Modusanzeige fest, wenn ClinicalExpress gestartet wird. 
Wenn Lizenzen für Allgemeine Radiographie und Mammographie erworben 
wurden, können Benutzer zwischen den Modi hin und her wechseln. 
 
Klicken Sie nach dem Ändern auf die Schaltfläche Anwenden (Apply). 
 
 
 
Autom. Ausfüllen Untersuchung (Auto Fill Study) 
 

 
 
Wenn diese Funktion aktiviert ist, wird automatisch das aktuelle Datum und/oder 
die Uhrzeit in eine neue Untersuchung eingegeben. 
 
Klicken Sie nach dem Ändern auf die Schaltfläche Anwenden (Apply). 
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Einstellen von Anzeigeparametern 
 
Legen Sie Anzeigeparameter unter Lokal | Anzeigeeinstellungen  
(Local | Display Settings) in der Baumstruktur Administration fest. 
 

 

Anzeigeeinstellungen voreinstellen 
 
Mit den Anzeigeeinstellungen werden automatisch die Fenster- und 
Ebeneneinstellungen für ein Bild basierend auf dem vom Benutzer ausgewählten 
Körperteil und der Modalität angewendet. Die Einstellungen basieren auf Filmtyp, 
Digitalisierertyp und Bit-Tiefe. Der Bildschirm oben zeigt vier voreingestellte 
Anzeigeeinstellungen. In diesem Bereich des Fensters Administration können 
Sie Anzeigeeinstellungen definieren, ändern und löschen. 
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 So erstellen Sie eine neue Anzeigeeinstellung: 
 

a. Klicken Sie auf die Schaltfläche Neu (New). 
 
b. Klicken Sie im Feld Modalität (Modality) und geben Sie dann die 

Modalität ein, 
 oder 
wählen Sie eine vorhandene Modalität aus der Liste aus. 

 
c. Klicken Sie im Feld Ansicht (View) und geben Sie die Ansicht ein. 
  oder 
 Wählen Sie eine vorhandene Ansicht aus der List aus. 
 
d. Geben Sie Fenster- und Ebenendaten für eine Bit-Tiefe ein. ClinicalExpress 

berechnet automatisch die entsprechenden Werte für die zwei anderen Bit-
Tiefen und füllt sie ein. 

 

  

Fenster Ebene 
 

 

Fenster Ebene 
 
e. Klicken Sie auf Speichern (Save). 

 
Hinweis: ClinicalExpress hat voreingestellte Fenster- 
und Ebeneneinstellungen für Körperteil (Body Part) = 
STANDARDEINSTELLUNG und Modalität (Modality) = 
STANDARDEINSTELLUNG. Diese Einstellungen werden 
anfänglich auf die Bilder angewendet. Der Benutzer kann 
die Einstellungen mit dem über die Maus gesteuerten Fenster-
Ebenen-Tool, durch Eingabe von Werten in die Felder 
Fenster (Window) und Ebene (Level) oder durch Verwendung 
der voreingestellten Fenster-/Ebenenwerte abändern. Der 
Administrator kann die Standardeinstellungen (links aufgelistet) 
wie nachfolgend beschrieben ändern. 
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 So ändern Sie die Fenster- und Ebenenwerte für eine vorhandene 
Anzeigeneinstellung: 

 
a. Klicken Sie auf die Zeile, die Sie ändern möchten. 
 
b. Klicken Sie auf die Schaltfläche Bearbeiten (Edit). 
 
c. Bearbeiten Sie Fensterdaten (linkes Feld) und/oder Ebenendaten (rechtes 

Feld) für eine Bit-Tiefe. ClinicalExpress berechnet automatisch die 
entsprechenden Werte für die zwei anderen Bit-Tiefen und füllt sie ein. 

 
d. Klicken Sie auf Speichern (Save). 

 
 
 So löschen Sie eine vorhandene Anzeigeeinstellung: 
 

a. Klicken Sie auf die Zeile, die Sie löschen möchten. 
 
b. Klicken Sie auf die Schaltfläche Löschen (Delete). 

 
 
 So wenden Sie automatisch Fenster- und Ebeneneinstellungen basierend auf 

Filmgröße und Bildauflösung an: Aktivieren Sie die Funktion Autom. 
Fenster/Ebene aktivieren (Enable Auto Window/Level) 
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Einstellen von Digitalisiererauflösungen 
 
Legen Sie Digitalisiererauflösungen unter Lokal | Digitalisierereinstellungen 
(Local | Digitizer Settings) in der Baumstruktur Administration fest. 
 

 
 
 
Digitalisierereinstellungen legen automatisch die Bildauflösung basierend auf der 
Filmbreite fest. 
 
 So ändern Sie eine Auflösung: 
 

a. Klicken Sie auf die Zeile mit der Filmgröße, die Sie ändern möchten. 
 
b. Doppelklicken Sie in der Spalte Auflösung (Resolution) dieser Zeile. 
 
c. Wählen Sie die gewünschte Auflösung. 
 
d. Klicken Sie auf Speichern (Save). 
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Einstellen von Bildbearbeitungsoptionen 
 
Legen Sie Bearbeitungsoptionen unter Lokal | Bildbearbeitungsoptionen 
(Local | Image Processing) in der Baumstruktur Administration fest. 
 

 
 
 

Hinweis: Standardeinstellungen im Fenster Bildbearbeitung 
(Image Processing) sind aus, d. h. nicht aktiviert. 
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Hinweis: Sobald ein Bild vom Digitalisierer aufgenommen wird 
(d. h. bevor es angezeigt oder gesendet wird), wendet 
ClinicalExpress die aktivierten Bildbearbeitungsvorgänge 
automatisch und permanent auf jedes Bild an. Der Benutzer 
kann die Ergebnisse der Bildbearbeitung nicht rückgängig 
machen. Wenn Bilder keine Bearbeitung benötigt hätten, muss 
der Administrator die Aktivierung der Optionen auf der Seite 
Bildbearbeitung (Image Processing) entfernen, dann muss 
der Benutzer die Filme neu digitalisieren, um neue Bilder zu 
generieren. 

 
1. Bei Bedarf Bildbearbeitungsoptionen einstellen: 
 
 Unscharfe Maske (Unsharp Mask): Wenn diese Funktion aktiviert ist, 

wendet ClinicalExpress den Algorithmus für unscharfe Masken an, um das 
Bild zu schärfen. Wählen Sie Niedrig (Low), Mittel (Medium) oder Hoch 
(High), um das Ausmaß der Scharfstellung zu regulieren. 

 
 DRC (Dynamische Bereichskompression) (Dynamic Range Compression): 

Wenn diese Funktion aktiviert ist, wendet ClinicalExpress einen nicht-linearen 
Filter an, um den dynamischen Bereich eines Bildes zu komprimieren. Wählen 
Sie Niedrig (Low), Mittel (Medium) oder Hoch (High), um das Ausmaß der 
Komprimierung zu regulieren. 

 
 Bearbeitung nach der Digitalisierung (Post-Digitization Processing): 
 Bildbegradigung nach der Digitalisierung (Straighten Image After 

Digitization): Wenn diese Funktion aktiviert ist, werden Bilder, die den 
Schwellenwert (Threshold Value) übersteigen, automatisch nach der 
Aufnahme begradigt. Wenn diese Funktion deaktiviert ist, kann der 
Benutzer Bilder im Fenster „ClinicalExpress“ begradigen. 

 Schwellenwert (Threshold Value): Das Bild muss um mehr als diesen Wert 
gedreht sein, um sich für die automatische Begradigung zu qualifizieren. 

 Zurücksetzen (Reset): Klicken Sie, um die Standard-Schwellenwerte 
wiederherzustellen. 

 
Hinweis: Bei der automatischen Bildbegradigung wird davon 
ausgegangen, dass die Filmkanten gerade sind und rechte 
Winkel aufweisen. Entfernen Sie die Aktivierung dieser Option, 
wenn Filme geschnitten wurden. 

 
 Monitor LUT: Wenn diese Funktion aktiviert ist, wendet ClinicalExpress 

LUT- (Look Up Table)-Werte auf das Bild an, bevor es angezeigt wird. 
 Von Datei (From File): Wählen Sie diese Option, wenn die 

Referenztabelle (Look Up Table) als Datei verfügbar ist. Geben Sie den 
Pfad und den Dateinamen ein, oder klicken Sie auf die Schaltfläche zum 
Durchsuchen, um die Datei zuzuweisen. 

 Mithilfe von Dichte generieren (Generate Using Density): Wählen Sie 
diese Option, wenn ClinicalExpress eine Referenztabelle basierend auf 
dem angegebenen Dichtewert generieren soll. 
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 SDF anwenden (Apply SDF): Wenn diese Funktion aktiviert ist, 
wendet ClinicalExpress mithilfe der festgelegten Werte für Beleuchtung 
(Illumination), Umgebungslicht (Ambient Light), Mindestdichte des 
Digitalisierers (DMin) und Höchstdichte des Digitalisierers (DMax) 
standardmäßige Anzeigefunktionswerte auf das Bild an, bevor es angezeigt 
wird. 

 
2. Klicken Sie auf die Schaltfläche Anwenden (Apply). 
 
 

Standard-DICOM-SDF-Werte 

Beleuchtung 2000 cd/m2 

Umgebungslicht 10 cd/m2 

DMin 0 

DMax 255 
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Definieren von Mammographie-Ansichten 
 

Ansichten liefern dem ClinicalExpress-Benutzer hängende Protokolle zum 
Zusammenfügen separater Mammographiebilder zu zusammengesetzten Bildern. 
ClinicalExpress wird mit einem Standard-2x2-Protokoll geliefert. Bei Bedarf 
können Sie andere Ansichten definieren. 
 

Hinweis: ClinicalExpress 6.0 wurde durch die Option zum 
Durchführen von Dokumentscans für Mammographie ergänzt. 
Falls Sie nicht über die PDI-Option verfügen, müssen Sie sie 
hinzufügen, um Dokumente auf einem Flachbett-Scanner scannen 
zu können. Außerdem müssen Sie ein Layout definieren, in dem 
die Filmansicht (Film View) auf PAPIER (PAPER) eingestellt ist. 

 

Legen Sie Ansichten unter Lokal | Mammographie (Local | Mammography) in 
der Baumstruktur Administration fest. 

 

 



 Konfigurieren von ClinicalExpress 43 

19746-001 Rev. E ClinicalExpress 6.1 Administratorhandbuch 

 
 
 
1. Klicken Sie auf die Schaltfläche Neu (New). 
 
2. Klicken Sie in der Liste Ansichten (Views) in der Spalte Name, geben Sie 

den Namen für das Layout ein und drücken Sie EINGABE. 
 

 
 
3. Öffnen Sie die Liste Layout und klicken Sie auf das gewünschte Layout 

Zeile x Spalte (row x column). 
 
4. Legen Sie in der Liste Ansichtsreihenfolge (View Order) die Filmansicht 

(Film View) für jede Zelle fest. Die Layout-Vorschau (Layout Preview) 
zeigt, wie Filmansichten zu Zellen hinzugefügt werden. 

 

  
 
 

Hinweis: Zum Scannen von Dokumenten setzen Sie 
Filmansicht (Film View) auf PAPIER (PAPER). 

 
Hinweis: Patientenausrichtung (Patient Orientation) wird 
automatisch festgelegt, wenn Sie eine Filmansicht (Film View) 
auswählen, und sollte nicht geändert werden. 

 
Hinweis: Der Benutzer kann die hier eingestellte 
Standardeinstellung Patientenausrichtung (Patient 
Orientation) ändern. 

 
 So löschen Sie eine Ansicht: 

a. Klicken Sie in der Liste Ansichten (Views) auf die Ansicht und klicken Sie 
dann auf die Schaltfläche Löschen (Delete). 

b. Bestätigen Sie die Löschung. 
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 So bearbeiten Sie eine Ansicht: 

a. Klicken Sie in der Liste Ansichten (Views) auf die Ansicht und klicken Sie 
dann auf die Schaltfläche Bearbeiten (Edit). 

b. Klicken Sie in der Liste Ansichten (Views), klicken Sie auf Name und 
geben Sie dann einen neuen Namen ein. 

c. Ändern Sie ggf. in der Liste Ansichtsreihenfolge (View Order) 
Filmansicht (Film View) und Patientenausrichtung (Patient Orientation). 

d. Klicken Sie auf Speichern (Save). 
 

Hinweis: Eine Ansicht kann nur dann gelöscht oder bearbeitet 
werden, wenn sie keinen Verweis aus einer Untersuchung enthält. 

 
 
Erläuterung der Ansichten und Patientenausrichtungen 
 
Die folgenden Beispiele verdeutlichen die Beziehungen zwischen Ansichten, 
Bildern und Patientenausrichtungen. 
 
Angenommen, Sie definieren zwei Ansichten wie folgt: 
 
Ansicht A 

Zeile Spalte Filmansicht Patientenausrichtung 

1 1 RCC PF 

1 2 LCC AF 

2 1 RLMO AFL 

2 2 LMLO PFL 

 
Ansicht B 

Zeile Spalte Filmansicht Patientenausrichtung 

1 1 RCC FL 

1 2 LCC PF 

2 1 RLMO PFL 

2 2 LMLO FR 

 
In Zellen abgelegte Bilder erhalten die standardmäßigen Patientenausrichtungen. 
Angenommen Ansicht A ist wirksam. Das in Zeile 1, Spalte 1 abgelegte Bild 
(RCC) bekommt die Standard-PF-Ausrichtung. 
 
Angenommen der Benutzer klickt mit der rechten Maustaste auf ein Bild, ändert 
die Ausrichtung zu PF und zieht das Bild dann zu Zeile 2, Spalte 2 (LMLO). 
Dieses Bild übersteuert die Standard-PFL-Ausrichtung und behält die 
benutzerseitig zugewiesene PF-Ausrichtung bei. 
 
Angenommen der Benutzer wählt Ansicht B für dieselbe Untersuchung. Bei 
diesem Vorgang werden die Standard-Patientenausrichtungen von Ansicht B 
auf die Bilder angewendet. Beispielsweise weist das Bild in RCC nun die 
Patientenausrichtung FL auf. 
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Angenommen der Benutzer schließt die Untersuchung. Anschließend bearbeiten 
Sie (der Administrator) Ansicht B und ändern damit die RCC-Patientenausrichtung 
zu AF. Wenn die Untersuchung neu geöffnet wird, weist das RCC-Bild die 
Patientenausrichtung FL auf (wurde beim Schließen mit der Untersuchung 
gespeichert), nicht AF (die Standard-RCC-Ausrichtung AF). Wenn jedoch ein Bild 
zur RCC-Zelle hinzugefügt wird, ist dessen Patientenausrichtung die Standard-
Ausrichtung AF. 
 
Erstellen von benutzerdefinierten Codes und 
benutzerdefinierten Ansichtsmodifizierer-Codes 
 
Sie können benutzerdefinierte Ansichtscodes erstellen, die in der Dropdown-
Liste in der Spalte Filmansicht (Film View) der Liste Ansichtsreihenfolge 
(View Order) unter Lokal | Mammographie (Local | Mammography) der 
Baumstruktur Administration erscheinen (weiter oben in diesem Abschnitt 
beschrieben). Sie können außerdem benutzerdefinierte Ansichtsmodifizierer-
Codes erstellen, die mit benutzerdefinierten Ansichtscodes verbunden werden. 
 

Hinweis: Bei Veröffentlichung dieses Handbuchs waren die 
benutzerdefinierten Ansichtscodes und die benutzerdefinierten 
Ansichtsmodifizierer-Codes nicht von DICOM oder IHE definiert. 
Die Entwicklung, Verwendung und Zuverlässigkeit von 
benutzerdefinierten Ansichtscodes und benutzerdefinierten 
Ansichtsmodifizierer-Codes liegt allein in der Verantwortung des 
ClinicalExpress-Benutzers. 

 
 So erstellen Sie einen benutzerdefinierten Ansichtscode: 

1. Klicken Sie unter Lokal | Mammographie (Lokal | Mammography) in der 
Baumstruktur Administration auf die Schaltfläche Benutzerdefiniert 
(Custom). Hierdurch wird das Fenster Mammographie-Ansicht anpassen 
(Customize Mammography View) geöffnet (siehe nächste Seite). 

2. Klicken Sie im Bereich Benutzerdefinierte Ansichtscodes (Custom View 
Codes) auf die Schaltfläche Neu (New). 

3. Klicken Sie in den einzelnen Spalten und geben Sie die zugehörigen 
Informationen ein. 

4. Klicken Sie auf Speichern (Save). 
 

 So bearbeiten Sie einen benutzerdefinierten Ansichtscode: 
1. Klicken Sie im Bereich Benutzerdefinierte Ansichtscodes (Custom View 

Codes) auf den Ansichtscode, den Sie bearbeiten möchten. 
2. Klicken Sie auf Bearbeiten (Edit). 
3. Ändern Sie die Informationen nach Bedarf. 
4. Klicken Sie auf Speichern (Save). 
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 So löschen Sie einen benutzerdefinierten Ansichtscode: Klicken Sie auf den 
Ansichtscode, den Sie löschen möchten, und klicken Sie auf Löschen (Delete). 

 
Hinweis: Ein benutzerdefinierter Ansichtscode kann nur dann 
bearbeitet oder gelöscht werden, wenn er keinen Verweis aus 
einer Untersuchung enthält. 

 
 So erstellen Sie einen benutzerdefinierten Ansichtsmodifizierer-Code: 

1. Klicken Sie im Bereich Benutzerdefinierte Ansichtsmodifizierer-Codes 
(Custom View Modifier Codes) auf die Schaltfläche Neu (New). 

2. Klicken Sie in den einzelnen Spalten und geben Sie die zugehörigen 
Informationen ein. 

3. Klicken Sie auf Speichern (Save). 
 

 So bearbeiten Sie einen benutzerdefinierten Ansichtsmodifizierer-Code: 
1. Klicken Sie im Bereich Benutzerdefinierte Ansichtsmodifizierer-Codes 

(Custom View Modifier Codes) auf den Modifizierercode, den Sie 
bearbeiten möchten. 

2. Klicken Sie auf Bearbeiten (Edit). 
3. Ändern Sie die Informationen nach Bedarf. 
4. Klicken Sie auf Speichern (Save). 
 

 So löschen Sie einen benutzerdefinierten Ansichtsmodifizierer-Code: Klicken 
Sie auf den Ansichtsmodifizierer-Code, den Sie löschen möchten, und klicken 
Sie auf Löschen (Delete). 

 
Hinweis: Ein benutzerdefinierter Ansichtsmodifizierer-Code 
kann nur dann bearbeitet oder gelöscht werden, wenn er keinen 
Verweis von einem benutzerdefinierten Ansichtscode enthält. 

 
Hinweis: Beim DICOM-Speichern und -Export werden 
benutzerdefinierte Ansichtscodes zur DICOM-Kopfzeile 
als Ansichtscode-Sequenz (0054, 0222) hinzugefügt. Alle 
Ansichtsmodifizierer-Codes werden als Ansichtsmodifizierer-
Code-Sequenz (0054, 0220) gesendet, die Teil der 
Ansichtscode-Sequenz ist. 
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Zuweisen obligatorischer Dateneingabefelder 
 
Dateneingabefelder in den Fenstern Patienteninformationen (Patient 
Information) und Untersuchungsinformationen (Study Information) können 
gemäß den Richtlinien Ihrer Organisation als Pflichtfelder zugewiesen werden 
(wird durch fett dargestellte Feldnamen angegeben). 
 
Legen Sie Pflichtfelder unter Lokal | Obligatorische Felder (Local | Mandatory 
Fields) in der Baumstruktur Administration fest. 
 

 
 
 
1. Legen Sie Pflichtfelder nach Bedarf fest: 
 
 So zwingen Sie den Benutzer zum Ausfüllen eines Feldes: Aktivieren Sie 

das Feld in der Spalte Obligatorisch (Mandatory). 
 
 So machen Sie ein Feld zu einem optionalen Feld: Entfernen Sie die 

Aktivierung im Feld Obligatorisch (Mandatory). 
 
2. Klicken Sie auf die Schaltfläche Anwenden (Apply). 
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Verwalten von Benutzerkonten 
 
Der Benutzermanager (User Manager) ermöglicht ClinicalExpress-
Administratoren das Hinzufügen, Ändern und Löschen von Benutzerkonten. 
 

Hinweis: Allen ClinicalExpress-Benutzern müssen „Power-
User“- Berechtigungen unter Windows 2000 oder Windows XP 
zugewiesen werden. 

 
Im Bereich Lokal | Benutzermanager (Local | User Manager) im Fenster 
Administration können Sie Benutzerkonten hinzufügen, ändern und entfernen. 
Die Anweisungen beginnen auf der nächsten Seite. 
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 So fügen Sie ein Benutzerkonto hinzu: 
 

a. Klicken Sie auf die Schaltfläche Hinzufügen (Add). Hierdurch wird das 
Fenster Benutzerinformationen (User Information) geöffnet. 

 

  
 
b. Bei einem neuen Benutzer geben Sie Benutzername (User Name) (z. B. 

der Anmeldename), Vollständiger Name (Full Name) und Beschreibung 
(Description) (z. B. berufliche Position) ein. Geben Sie ein Passwort 
(Password) für den Benutzer ein und geben Sie das Passwort erneut in 
Passwort bestätigen (Confirm Password) ein. 

 
c. Klicken Sie auf Erstellen (Create). 
 
 

 So ändern Sie den vollständigen Namen, die Beschreibung oder das Passwort 
eines Benutzers: 
 
a. Klicken Sie in der Benutzerliste (user list) auf die Benutzerkonto-Zeile. 
 
b. Klicken Sie auf die Schaltfläche Bearbeiten (Edit). 
 

  
 
c. Ändern Sie die Informationen nach Bedarf. 
 
d. Klicken Sie auf Speichern (Save). 
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Hinweis: Der Anmeldename eines Benutzers (User Name) kann 
nicht geändert werden. Um einen Benutzernamen zu ändern, 
löschen Sie das Benutzerkonto und erstellen Sie wie oben in 
diesem Abschnitt beschrieben ein neues Benutzerkonto. 

 
Hinweis: Das Passwort des Administrators kann geändert werden, 
aber der Benutzername des Administrators kann nicht geändert 
werden. Bewahren Sie das Administrator-Passwort an einem 
sicheren Ort auf. 

 
 

 So entfernen Sie ein Benutzerkonto: 
 
a. Klicken Sie in der Benutzerliste (user list) auf die Benutzerkonto-Zeile. 
 
b. Klicken Sie auf Entfernen (Remove). 

 
Hinweis: Das Administrator-Benutzerkonto kann nicht gelöscht 
werden. 

 
 
 
Passwörter können nicht wieder abgerufen werden. Wenn ein Benutzer sein 
Passwort vergisst, müssen Sie das Konto des Benutzers löschen und ein neues 
Konto für den Benutzer erstellen. 
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Auswählen von Datenfeldern für die Anonymisierung 
 
Um die Datenschutzrechte des Patienten zu schützen, können Daten in 
bestimmten Feldern anonymisiert (entfernt oder durch feste Werte ersetzt) 
werden, wenn Untersuchungen an ein Ziel gesendet werden. Die ursprünglichen 
in der ClinicalExpress-Datenbank gespeicherten Daten werden nicht geändert, 
wenn die Anonymisierung während der Übertragung angewendet wird. 
 
Das Einrichtung von Daten für die Anonymisierung erfolgt in zwei Schritten: 
1. Zuweisen von Feldern, die anonymisiert werden sollen (siehe Beschreibung in 

diesem Abschnitt). 
2. Aktivieren der Option Anonymisieren (Anonymize) für Ziele (siehe 

Beschreibung unter „Definieren von Zielen“ im nächsten Abschnitt dieses 
Kapitels). 

 
Hinzufügen, Ändern oder Entfernen anonymisierter Felder im Bereich  
Lokal | Anonymisieren (Local | Anonymize) im Fenster Administration. 
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 So weisen Sie ein Feld für die Anonymisierung zu: 
 

a. Klicken Sie auf die Schaltfläche Hinzufügen (Add). Hierdurch wird das 
Fenster Anonymisierer-Element-Informationen (Anonymizer Element 
Information) geöffnet. 

 

  
 

b. Öffnen Sie die Liste Name, und klicken Sie in das Feld, das anonymisiert 
werden soll. Die folgenden Felder können anonymisiert werden: 
 Patientenname 
 Patienten-ID 
 Geburtsdatum 
 Geschlecht 
 Aufnahmenummer 
 Untersuchungsdatum 
 Untersuchungszeit 
 Untersuchungsbeschrei-

bung 
 Serienbeschreibung 

 Diagnose bei Einweisung 
 Name des überweisenden Arztes 
 Einrichtung 
 Modalität 
 Hersteller 
 Untersuchungs-ID 
 Seriennummer 
 Instanznummer 
 Konvertierungstyp 
 Untersuchtes Körperteil 

 
c. Optional: Geben Sie einen Wert (Value) ein, mit dem die Patientendaten 

ersetzt werden sollen. Wenn kein Wert eingegeben wird, bleibt das Feld bei 
der Anonymisierung leer. 

 
d. Klicken Sie auf OK. 

 
 So bearbeiten Sie die anonymisierten Werte für ein Feld: 
 

a. Klicken Sie auf die Zeile für das Feld, das Sie ändern möchten. 
 

b. Klicken Sie auf die Schaltfläche Bearbeiten (Edit). 
 

c. Ändern Sie den Wert (Value) im Fenster Anonymisierer-Element-
Informationen (Anonymizer Element Information). 

 

d. Klicken Sie auf OK. 
 

 So entfernen Sie die Anonymisierung für ein Feld: 
 

a. Klicken Sie auf die Zeile, die entfernt werden soll. 
 

b. Klicken Sie auf die Schaltfläche Entfernen (Remove). 
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Sichern und Wiederherstellen der Lizenz 
 
Für ClinicalExpress-Installationen wird Lizenzsicherung bereitgestellt. Diese 
Funktion sollte kurz nach der Installation von ClinicalExpress eingerichtet 
werden. Damit können Sie den Lizenzschlüssel an einem sicheren Ort – z. B. 
einem Netzwerkverzeichnis oder auf einem Flash-Laufwerk (USB-Stick) – 
speichern, um die Lizenz im Falle eines Hardware- und Softwareproblems 
wiederherstellen zu können. 
 
Die Lizenzsicherungsdatei zeichnet die Anzahl der verbleibenden Scans und die 
zeitliche Begrenzung für die Lizenz auf. Diese Datei wird anhand der letzten 
Scan- und Zeitdaten alle 24 Stunden erneut erstellt, indem die vorherige Kopie 
überschrieben wird (daher ist die Sicherung auf CD oder DVD nicht möglich). 
Wenn ClinicalExpress nicht läuft, wenn eine Sicherung fällig wird, erfolgt die 
Sicherung beim nächsten Starten der Anwendung. 
 

Lizenz sichern 
 
Sichern Sie die Lizenz im Bereich Lokal | Lizenzsicherung (Local | License 
Backup) im Fenster Administration. 
 

 
 
 
 So sichern Sie die Lizenz: 
 

a. Aktivieren Sie die Option Lizenzsicherung aktivieren (Enable License 
Backup). 

b. Klicken Sie auf die Schaltfläche Mehr  und wählen Sie die Stelle aus, 
an der die Lizenz gespeichert werden soll. 

 
Hinweis: Wählen Sie keine Speicherstelle auf dem lokalen 
Computer. Wählen Sie z. B. ein Netzwerkverzeichnis oder einen 
USB-Stick, der immer im Computer eingesteckt ist und nicht 
beeinträchtigt wird, wenn der lokale Computer Probleme 
aufweist oder ersetzt werden muss. 

 
c. Klicken Sie auf die Schaltfläche Lizenz sichern (Backup License). 
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Wiederherstellen der Lizenz 
 
Bei einem Hardware- oder Softwareproblem mit dem Computer, auf dem 
ClinicalExpress ausgeführt, kann VIDAR Ihre Lizenz wiederherstellen, wenn 
Sie die Option „Lizenzsicherung“ (License Backup) aktiviert haben (auf der 
vorherigen Seite beschrieben). 
 
1. Starten Sie eine neue E-Mail-Nachricht. 
 
2. Geben Sie im Adressfeld medtech@3dsystems.com ein. 
 
3. Machen Sie die Lizenzdatei ausfindig (weist die Erweiterung .ref auf) und 

hängen Sie sie an die Nachricht an. 
 
4. Beschreiben Sie im Hauptteil der Nachricht die Situation und bitten Sie um 

die Wiederherstellung Ihrer Lizenz. 
 
5. Senden Sie die Nachricht. 
 
6. Wenn Sie eine Antwort mit der wiederhergestellten Lizenz erhalten, 

installieren Sie die Lizenz wie in Schritt 2 in Abschnitt „E. ClinicalExpress-
Lizenzschlüssel anfordern“ im Kapitel „Installieren von ClinicalExpress“ in 
diesem Handbuch beschrieben. 

 
Wenn Sie keine Kopie Ihrer Lizenz bereitstellen können, müssen Sie eine neue 
Lizenz erwerben. 
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Definieren von Zielen 
 
Administratoren können Parameter für Ziele und Remote-Geräte einrichten, 
bearbeiten und löschen. Ein Ziel ist die Destination für Untersuchungen und/oder 
eine Quelle für Modalität-Arbeitslisten-Daten. (Die Modalitäts-Arbeitsliste kann 
separat erworben werden.) 
 
Unter Ziele (Targets) in der Baumstruktur Administration können Sie mit Zielen 
arbeiten. 
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Erstellen eines neuen Ziels 
 
1. Klicken Sie auf die Schaltfläche Neu (New). Hiermit wird die Seite Neues 

Ziel (New Target) angezeigt. 
 

  
 
2. Im Bereich Ziel (Target): 
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a. Geben Sie den Namen für das Ziel ein. Dabei sollte es sich um einen 
eindeutigen, kurzen Namen handeln, z. B. „Klinik“ oder „Dr. Gale“. 
Wählen Sie möglichst unverwechselbare Namen. 

 
Hinweis: Nachdem der Name eingegeben und das Ziel 
gespeichert wurde, kann der Name nicht mehr geändert werden. 
Um den Namen zu ändern, müssen Sie das Ziel löschen und ein 
neues erstellen. 

 
b. Wählen Sie den Zieltyp (Type). Folgende Optionen stehen zur Auswahl: 
 DICOM-SPEICHER 
 SPEICHERÜBERNAHME 
 VON MODALITÄT AUSGEFÜHRTER VERFAHRENSSCHRITT 
 DICOM-DRUCKER 
 POSTSCRIPT-DRUCKER 
 DICOM-CD 
 MODALITÄT-ARBEITSLISTE 
 DICOM-PATIENTENANFRAGE 

 
Hinweis: Das Feld Zieltyp (Type) steuert, welche Felder im 
linken Satz der Bereiche des Fensters Neues Ziel (New Target) 
geändert werden können und steuert Felder, die im rechten 
Bereich Konfiguration (Configuration) angezeigt werden. 

 
c. (Optional) Geben Sie eine Beschreibung (Description) für das Ziel ein. 
 
d. So weisen Sie dieses Ziel als Standard zu: Aktivieren Sie die Option Standard 

(Default). Informationen aus dem Standardziel erscheinen im Bereich Ziel 
(Target) im ClinicalExpress-Hauptfenster, wenn das Programm gestartet wird 
und der Benutzer auf die Schaltfläche Standard-Ziel (Default Target) klickt. 

 
Tipp: Wenn die Workstation Untersuchungen nur an ein Ziel 
senden soll oder wenn ein Ziel die meiste Zeit als Ziel dient, 
legen Sie dieses Ziel als Standardwert fest. 

 
e. So anonymisieren Sie Daten, die an dieses Ziel gesendet werden: Aktivieren 

Sie die Option Anonymisieren (Anonymize). Felder, die im Fenster Lokal | 
Anonymisieren (Local | Anonymize) für die Anonymisierung ausgewählt 
sind (siehe vorigen Abschnitt „Auswählen von Datenfeldern für die 
Anonymisierung“ in diesem Kapitel). 

 
f. So erlauben Sie verlustlose Baseline-JPEG-Komprimierung für dieses Ziel: 

Aktivieren Sie Verlustlose Komprimierung zulassen (Allow Lossless 
Compression). 
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3. Im Bereich Kommunikation (Communication): 
 

  
 

a. Geben Sie den AE-Titel (Application Entity-Titel) des Remote-Ziels ein. 
Bei der Eingabe von AE-Titeln ist die Groß-/Kleinschreibung zu beachten. 

 
b. Geben Sie die PDU-Größe (Protocol Data Unit-Größe) in Byte ein. Dies gibt 

die maximale Blockgröße an, die das Ziel von ClinicalExpress erhalten kann. 
 

Hinweis: AE-Titel und PDU-Größe werden normalerweise vom 
empfangenden Programm definiert. 

 
c. Geben Sie die erforderliche Antwortfrist (Response Timeout) in Minuten ein. 

Dieser Wert gibt an, wie lange ClinicalExpress auf eine Antwort wartet, 
nachdem eine Kommunikation an das Ziel gesendet wurde. Hohes 
Netzwerkverkehrsaufkommen verlangsamt den Betrieb von ClinicalExpress. 
Der maximale Wert ist 5 Minuten. Um keine Frist festzulegen, geben Sie 0 ein. 

 
d. Geben Sie die Port-Nummer der empfangenden Anwendung ein  

(z. B. 104, 4006). 
 
e. Geben Sie den Host-Namen oder die IP-Adresse der empfangenden 

Anwendung ein. 
 
f. Wenn über eine Einwählverbindung auf das Ziel zugegriffen wird, 

aktivieren Sie Einwählen (Dial-up) und geben Sie die erforderlichen 
Informationen ein. 
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4. Im Bereich Digitalisierer (Digitizer) können Sie die standardmäßige Bit-Tiefe 
und Auflösung einstellen und festlegen, ob Benutzer die Standardeinstellungen 
ändern können. Die standardmäßige Bit-Tiefe beträgt 16 und die Auflösung 
beträgt 570. Im Bereich Digitalisierer (Digitizer): 

 

  
 

a. Aktivieren der Filmgröße für die eingestellte Auflösung: Aktivieren Sie die 
Option Filmgrößen-basierte Auflösung einstellen (Set Film Size Based 
Resolution). 

 
b. Ändern der standardmäßigen Bit-Tiefe und Auflösung: Aktivieren Sie die 

Option Bit-Tiefe und Auflösung aktivieren (Enable Bit Depth and 
Resolution) und stellen Sie Bit-Tiefe (Bit Depth) und Auflösung (Resolution) 
auf die erforderlichen Werte ein. (Die verfügbaren Werte sind vom 
angeschlossenen Digitalisierer abhängig.) 

 
c. So aktivieren Sie die standardmäßige Bit-Tiefe und Auflösung: Aktivieren 

Sie die Option Bit-Tiefe und Auflösung aktivieren (Enable Bit Depth 
and Resolution), oder lassen Sie die Option aktiviert. Überlegungen: 
 Deaktivieren Sie die Option Bit-Tiefe und Auflösung aktivieren (Enable 

Bit Depth and Resolution), wenn das Ziel Bilder empfangen soll, die mit 
einer bestimmten Bit-Tiefe und Auflösung erfasst wurden. Dies ist die 
empfohlene Konfiguration, wenn Sie nicht die Option Filmgrößenbasierte 
Auflösung einstellen (Set Film Size Based Resolution) verwenden. 

 Aktivieren Sie die Option Bit-Tiefe und Auflösung aktivieren (Enable 
Bit Depth and Resolution), wenn das Ziel Bilder empfangen kann, die 
bei jeder beliebigen Bit-Tiefe und Auflösung erfasst wurden, und wenn 
ClinicalExpress-Benutzer in der Auswahl der entsprechenden Einstellungen 
für die Untersuchung und das Ziel geschult sind. 

 
Hinweis: Jede Einrichtung ist dafür verantwortlich sicherzustellen, 
dass Bit-Tiefe und Auflösung für die Bilder und Untersuchungen 
angemessen sind, für die ClinicalExpress verwendet wird. 
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5. Die Optionen im Bereich Konfiguration (Configuration) sind vom 
ausgewählten Zieltyp abhängig. Befolgen Sie die Anweisungen für den 
ausgewählten Zieltyp. 

 
 
 Für den Zieltyp DICOM-SPEICHER: 
 

  
 

a. Wenn eine Referenztabelle für das Ziel verfügbar ist, aktivieren Sie 
LUT und klicken Sie dann auf die Schaltfläche ... (siehe Pfeil), um die 
LUT-Datei auszuwählen. 

 
b. Wenn ClinicalExpress auf Speicherübernahme-Mitteilungen von einem 

Ziel reagieren soll: 
 Aktivieren Sie Speicherübernahme (Storage Commitment). 
 Wählen Sie ein Ziel aus, oder wählen Sie für diese Option Gleich 

(Same), um es auf das aktuelle Ziel anzuwenden. 
 Geben Sie eine Maximale Wartezeit (Maximum Wait Time) ein. 

ClinicalExpress wird nur aktiv, wenn innerhalb dieses Zeitraums eine 
Speicherübernahme-Bestätigung eingeht. 

 
 
 Für den Zieltyp SPEICHERÜBERNAHME: 
 

  
 
 Geben Sie eine Maximale Wartezeit (Maximum Wait Time) ein. 

ClinicalExpress wird nur aktiv, wenn innerhalb dieses Zeitraums eine 
Speicherübernahme-Bestätigung eingeht. 

 
 
 Für den Zieltyp VON MODALITÄT AUSGEFÜHRTER 

VERFAHRENSSCHRITT gibt es keine Konfigurationsoptionen. 
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 Für den Zieltyp DICOM-DRUCKER: 
 

  
 

a. Wenn eine Referenztabelle für den Drucker verfügbar ist, aktivieren Sie 
die LUT und klicken Sie dann auf die Schaltfläche ... (siehe Pfeil), um 
die LUT-Datei auszuwählen. Verfügbare LUTs befinden sich im Drucker-
spezifischen Verzeichnis auf der ClinicalExpress-Installations-CD. 

 
b. Wenn keine Referenztabelle für den Drucker verfügbar ist, aktivieren 

Sie Standard-Display-Funktion anwenden (Apply SDF), und dann: 
 Passen Sie den Druckertyp (Printer Type) an den DICOM-Drucker an. 
 Setzen Sie den Transformationstyp (Transformation Type) auf SCP 

(Drucker wendet SDF auf Bild an) oder SCU (ClinicalExpress wendet 
SDF auf Bild an). Wenn der Transformationstyp (Transformation 
Type) gelten soll, sollte der DICOM-Drucker die „Präsentations-LUT-
SOP-Klasse“ (Presentation LUT SOP Class) unterstützen (für Details 
siehe Druckerhandbuch); dies wird während der Zuweisungsphase von 
der Software ausgehandelt. 

 Wenn SDF auch dann auf Bild anwenden, wenn dies nicht vom 
Drucker unterstützt wird (Apply SDF on image even if not supported 
by printer) aktiviert ist und der Drucker nicht die „Präsentations-SOP-
Klasse" unterstützt (im Druckerhandbuch nachschlagen), generiert 
ClinicalExpress die SDF-Werte (basierend auf den Feldern 
Beleuchtung (Illumination) und Umgebungslicht (Ambient Light) und 
wendet eine LUT auf das Bild an, bevor es zum Drucker gesendet wird. 
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 Geben Sie Werte für Beleuchtung (Helligkeit durch Beleuchtung) 
und Umgebungslicht (Helligkeit durch Umgebungslicht) ein, die 
in der SDF-Berechnung verwendet werden sollen. Die DICOM-
Standardwerte lauten: 

 Durchlässige Medien 
(Transmissive media) 
(Film) 

Reflektierende Medien 
(Reflective media) 
(Papier) 

Beleuchtung 
(Illumination) 

2000 cd/m2 150 cd/m2 

Umgebungslicht 
(Ambient Light) 

10 cd/m2 0 cd/m2 

 
c. Im Bereich Einstellungen (Settings): 
 Stellen Sie bei Bedarf Vergrößerung (Magnification) ein. Folgende 

Optionen stehen zur Auswahl: 
 Replizieren (Replicate) (jeder Druckerpixel repräsentiert einen 

Bildpixel). 
 Keine (None) (passt das Bild ohne Resampling an die 

Druckergröße an). 
 Bilinear (passt das Bild mithilfe von bilinearem Resampling 

an die Druckergröße an). 
 Kubisch (Cubic) (passt das Bild mithilfe von kubischem 

Resampling an die Druckergröße an). 
 Setzen Sie Filmausrichtung (Film Orientation) auf Hochformat 

(Portrait, Längskante ist vertikal) oder Querformat (Landscape, 
Längskante ist horizontal). 

 Wählen Sie die Medien des Ziels aus: Blaufilm, Klarfilm oder Papier. 
 Legen Sie die Filmgröße (Film Size) des Ziels in Zoll fest. 
 Legen Sie Mindest-Filmtransparenz (DMin) und Höchst-

Filmtransparenz (DMax) fest. 
 Aktivieren Sie Wahre Größe (True Size), um das genaue 

Seitenverhältnis des ursprünglichen Films zu drucken. Falls diese 
Funktion nicht aktiviert ist, wird das Seitenverhältnis des Bildes 
geändert, damit es in den bedruckbaren Bereich passt. 

 Bedruckbarer Bereich (Printable Area) bezieht sich auf den 
bedruckbaren Bereich, der verwendet wird, um das Bild zuzuschneiden, 
wenn die angeforderte Ausgabegröße größer als der bedruckbare 
Bereich des Druckers ist. 
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Weitere Informationen über den bedruckbaren Bereich 

Ein duplizierter Film weist gewöhnlich einen kleineren Druckbereich auf als der Originalfilm mit derselben 
Gesamtgröße.  

 Wenn ein Bild auf Medien von derselben Größe wie der Originalfilm gedruckt wird, ist Schrumpfen oder 
Zuschneiden zu erwarten (je nach den Einstellungen im Bereich Konfiguration (Configuration) des Ziels 
DICOM-DRUCKER und vom Server und Drucker bereitgestellten verfügbaren Optionen). 

 Wenn ein Bild gedruckt wird, das kleiner als der bedruckbare Bereich (gewöhnlich 14 x 17 Zoll) des 
Druckers ist, wird das duplizierte Bild dieselbe Größe wie das Originalbild aufweisen. 

Beispiel: Angenommen der bedruckbare Bereich beträgt 13,5 x 16,5 Zoll, und die Auflösung beträgt 150 PPI. 
Der Bedruckbare Bereich (Printable Area) beträgt dann: 

14X17: 2025,2475 

wobei 14X17 die Originalfilmgröße ist (muss den Großbuchstaben „X“ aufweisen) 

 2025 die bedruckbare Breite in Pixel (13,5 Zoll x 150 PPI) ist 

 2475 die bedruckbare Länge in Pixel (16,5 Zoll x 150 PPI) ist 

 
 

 Für den Zieltyp POSTSCRIPT-DRUCKER: 
 

  
 

a. Wenn eine Referenztabelle für das Ziel verfügbar ist, aktivieren Sie 
LUT und klicken Sie dann auf die Schaltfläche ... (siehe Pfeil), um die 
LUT-Datei auszuwählen. Verfügbare LUTs befinden sich im Drucker-
spezifischen Verzeichnis auf der ClinicalExpress-Installations-CD. 

 
b. Klicken Sie auf Einstellungen (Settings), um das standardmäßige 

Fenster Druckeinrichtung (Print Setup) zu öffnen. In diesem Fenster 
können Sie einen Drucker auswählen und dessen Eigenschaften ändern. 

 
Hinweis: Postscript-Druckertreiber müssen installiert sein, um 
diesen Zieltyp zu unterstützen. Informationen über Treiber 
entnehmen Sie bitte dem Druckerhandbuch. 
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 Für den Zieltyp DICOM-CD: 
 

  
 

a. Legen Sie die Anzahl der zu erstellenden Kopien fest. 
 
b. Wählen Sie das CD-Laufwerk. 
 
 

 Für den Zieltyp MODALITÄT-ARBEITSLISTE. 
 

  
 

a. Aktivieren Sie Nur Patienteninformationen verwenden (Use Only 
Patient Information), um nur grundlegende Patienteninformationen aus 
einer Modalität-Arbeitslistenabfrage zu importieren. 

 
b. Aktivieren Sie Breite Abfrage aktivieren (Enable Broad Query), wenn 

das System auf mehrere Modalität-Arbeitslisten zugreifen kann und Sie 
wünschen, dass der Benutzer alle MALs mit einer einzelnen Abfrage 
durchsucht. 

 
c. Aktivieren Sie Geplantes Verfahrensschritt-Startdatum zu 

Untersuchungsdatum (Scheduled Procedure Step Start Date to Study 
Date), um das Verfahrensdatum einem Untersuchungsdatum zuzuordnen, 
wenn Sie durch Abfrage des MAL-Servers ein neues Patientenkonto 
erstellen. 

 
d. Aktivieren Sie Angeforderte Verfahrens-ID zur Untersuchungs-ID 

(Requested Procedure ID to Study ID), um eine angeforderte 
Verfahrens-ID einer Untersuchungs-ID zuzuordnen. 

 
 
 Für den Zieltyp DICOM-PATIENTENABFRAGE gibt es keine 

Konfigurationsoptionen. 
 
 
6. Wenn alle Zielinformationen eingegeben wurden, klicken Sie auf die 

Schaltfläche Speichern (Save). Das neue Ziel erscheint im Bereich Ziele 
(Targets) im Fenster Administration. 
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Verwalten von Zielinformationen 
 
 
 So listen Sie vorhandene Ziele auf: Klicken Sie in der Administration-

Baumstruktur auf Ziele (Targets). 
 

 
 
 
 So zeigen Sie die Einstellungen eines Ziels an: Klicken Sie auf den Namen des 

Ziels unter Ziele (Targets) in der Administration-Baumstruktur. 
 
 
 So bearbeiten Sie die Informationen eines Ziels: 

 
a. Klicken Sie auf den Namen des Ziels unter Ziele (Targets) in der 

Administration-Baumstruktur. 
  oder 
 Klicken Sie auf den Namen des Ziels in der Ziel-Zusammenfassungsliste. 
 
b. Klicken Sie auf die Schaltfläche Bearbeiten (Edit). Felder werden aktiviert 

und können bearbeitet werden. 
 
c. Klicken Sie anschließend auf die Schaltfläche Speichern (Save). 

 
 
 So löschen Sie ein Ziel: 

 
a. Klicken Sie auf den Namen des Ziels unter Ziele (Targets) in der 

Administration-Baumstruktur. 
  oder 
 Klicken Sie auf den Namen des Ziels in der Ziel-Zusammenfassungsliste. 
 
b. Klicken Sie auf die Schaltfläche Löschen (Delete). 
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Überprüfen der Kommunikation 
 
Nachdem Sie ein Ziel definiert haben, wird empfohlen, die Kommunikation 
zwischen ClinicalExpress und dem Ziel oder MAL-Broker zu überprüfen 
(die ClinicalExpress MAL-Funktion kann separat erworben werden). Natürlich 
können Sie dies zu jeder beliebigen Zeit überprüfen. 
 
1. Gehen Sie im ClinicalExpress-Hauptfenster zu Datei > Testmuster 

generieren > SMPTE (File > Generate Test Pattern > SMPTE). Hierfür wird 
eine speziell aufgenommene Untersuchung verwendet, die ausschließlich zu 
Testzwecken existiert. 

 
2. Öffnen Sie die Liste Ziel (Target) und klicken Sie auf das Ziel, das getestet 

werden soll. 
 
3. Klicken Sie im Bereich Ziel (Target) auf die Schaltfläche Überprüfen 

(Verify) (direkt unter der Dropdown-Liste „Ziel“). 
 
4. Warten Sie, bis ClinicalExpress antwortet. Es wird eine von zwei Meldungen 

angezeigt: 
 
 „Ziel – [Zielname]. Überprüfungsanforderung erfolgreich” (Target – [target 

name]. Verification request succeeded) bedeutet, dass das Ziel erfolgreich 
auf den DICOM Echo-Befehl von ClinicalExpress geantwortet hat. 

 
 „Ziel – [Zielname]. Überprüfungsanforderung fehlgeschlagen” (Target – 

[target name]. Verification request failed) bedeutet, dass das Ziel nicht auf 
den Echo-Befehl geantwortet hat. Wenn Sie diese Meldung sehen, 
überprüfen Sie die Zielkonfigurationsdetails in ClinicalExpress und stellen 
Sie sicher, dass das Netzwerk korrekt funktioniert. 

 
 

Überprüfen der Konfiguration des Filmdigitalisierers 
 
Betrachten Sie die Digitalisierer-Konfiguration unter Digitalisierer (Digitizer) in 
der Baumstruktur Administration. 
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Überprüfen der Verfügbarkeit von „Modalität-Arbeitsliste“ 
(Modality Work List) 

 
Hinweis: Die ClinicalExpress-Option „Modalität-Arbeitsliste“ 
(Modality Work List) kann separat erworben werden. Ihre Kopie 
von ClinicalExpress muss für die Modalität-Arbeitsliste lizenziert 
sein, bevor diese Funktion verfügbar wird. 

 
Hinweis: Bei der Anleitung in diesem Abschnitt wird davon 
ausgegangen, dass der Administrator die Schritte zum Erstellen 
eines neuen „Modalität-Arbeitsliste“-Ziels durchgeführt hat 
(siehe den Abschnitt „Definieren von Zielen“ weiter oben in 
diesem Kapitel). 

 
 So stellen Sie fest, ob die Option „Modalität-Arbeitsliste“ installiert ist: 
 

a. Gehen Sie im Hauptfenster zu Ansicht > Aufgenommene 
Untersuchungen (View > Acquired Studies). 

 
b. Markieren Sie im Fenster Untersuchungsinformationen (Studies 

Information) die Liste Ziele (Targets): 
 Wenn die Liste mindestens ein Ziel enthält, ist die Option „Modalität-

Arbeitsliste“ installiert und wurde bereits für ein Modalität-Arbeitsliste-
Ziel eingerichtet. 

 Wenn die Liste leer ist, ist die Option „Modalität-Arbeitsliste“ nicht 
installiert. 

 
c. Klicken Sie im Fenster Untersuchungsinformationen (Studies Information) 

auf Schließen (Close). 
 
 
 So überprüfen Sie, ob die ClinicalExpress-Workstation mit einer Modalität-

Arbeitsliste-Quelle verbunden ist: 
 

a. Öffnen Sie im Hauptfenster die Liste Ziel (Target) und klicken Sie auf ein 
Modalität-Arbeitsliste-Ziel. 

 

  
 
b. Klicken Sie auf Überprüfen (Verify). 
 
c. Ein Nachrichtenfenster teilt Ihnen mit, ob die Verbindung funktioniert. 

 
Hinweis: Vollständige Anweisungen zur Verwendung der 
Modalität-Arbeitsliste finden Sie unter „Importieren vorhandener 
Patientendaten mithilfe der Modalität-Arbeitsliste” im 
ClinicalExpress-Bedienungshandbuch. 
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Überprüfen und Verwalten der Protokolldatei 
 
Die Protokolldatei – eine im Programmverzeichnis gespeicherte Textdatei – 
enthält einen Datensatz der von ClinicalExpress durchgeführten Verfahren. 
Verwenden Sie die Protokolldatei, um Benutzer- und Programmaktivitäten für 
Fehlerbehebungszwecke zu prüfen und analysieren. ClinicalExpress bietet ein 
Fenster zum Anzeigen und Verwalten der Protokolldatei. 
 
 

 
 
 
 So zeigen Sie die Protokolldatei an: Ansicht > Protokolldatei (View > Log File). 
 
 So entfernen Sie Daten aus der Protokolldatei: Klicken Sie auf die Schaltfläche 

Protokoll leeren (Clear Log). 
 
 So lesen Sie neue Daten in die Protokolldatei ein: Klicken Sie auf die Schaltfläche 

Aktualisieren (Refresh). 
 
 

Hinweis: Legen Sie Protokolloptionen auf der Administrationsseite 
Lokal (Local) fest (siehe „Protokoll“ im Abschnitt „Einstellen von 
lokalen Workstation-Parametern“ weiter oben in diesem Kapitel). 
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Kalibrieren des Filmdigitalisierers 
 
Kalibrieren Sie den Filmdigitalisierer gemäß den Empfehlungen im Handbuch 
für den Filmdigitalisierer. 
 

Hinweis: Die Kalibrierung dauert mehrere Minuten; in dieser 
Zeit kann der Digitalisierer oder ClinicalExpress nicht verwendet 
werden. 

 
 So kalibrieren Sie den Filmdigitalisierer: 
 

a. Optionen > Scanner kalibrieren (Options > Calibrate Scanner). 
 
b. Bestätigen Sie, dass Sie eine Kalibrierung initiieren möchten. 
 

  
 
c. Warten Sie, während der Filmdigitalisierer kalibriert wird. 
 

  
 
d. Wenn die Kalibrierung abgeschlossen ist, klicken Sie auf Ja (Yes). 
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Kalibrieren Ihrer Anzeige 
 
Eine gute Bildqualität ist abhängig von der richtigen Anzeigeausgabe. Wenn Ihre 
Anzeige ein Bild präzise darstellt, können Sie die Bildqualität effektiv beurteilen 
und das Bild erfolgreich optimieren. Selbst wenn der Film korrekt digitalisiert 
wurde, kann das Bild den Anschein von schlechter Qualität oder einer nicht-
kalibrierten Anzeige haben. Dieser Abschnitt beschreibt zwei Methoden zur 
Kalibrierung einer Anzeige. 
 
Melden Sie Anzeigeprobleme dem Medizintechniker, der für die Anzeigequalität 
verantwortlich ist. Anzeigeprobleme sollten durch gründliche Prüfungen 
untersucht werden. Anschließend sollten Anpassungen, Service, Reparatur oder 
der Austausch des Geräts durchgeführt werden. 
 
Für eine rigorosere Anzeigekalibrierung empfiehlt VIDAR die VeriLUM-
Produkte, verfügbar von: 
 
 IMAGE Smiths, Inc. 
 P.O. Box 30928 
 Bethesda, MD 20824 USA 
 
 Telefon: +1 (240) 395-1600 
 Internet: www.image-smiths.com 
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Kalibrieren mit dem SMPTE-Testmuster 
 
1. Datei > Testmuster generieren > SMPTE (File > Generate Test Pattern > 

SMPTE), um das SMPTE-Musterbild zu öffnen (unten abgebildet). 
 
2. Minimieren Sie den Kontrast und die Helligkeit der Anzeige. 
 
3. Erhöhen Sie die Helligkeit, bis Sie nur die Streifen in den Ecken sehen können. 
 
4. Erhöhen Sie den Kontrast auf ca. 80 % oder mehr, bis Sie die 0 %/5 %- und 

95 %/100 %-Quadrate auf dem Bild so deutlich wie möglich sehen. 
 
 

 
 

0 %/5 %-Quadrat 95 %/100 %-Quadrat 
 
 

Hinweis: Wenn Sie dieses Dokument als elektronisches Dokument 
auf einer Anzeige lesen und weder das 0 %/5 %-Quadrat noch 
das 95 %/100 %-Quadrat auf dieser Seite (durch die Pfeile 
gekennzeichnet) sehen, muss Ihre Anzeige kalibriert werden. 
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Kalibrieren mit dem TG18-QG-Testmuster 
 
1. Datei > Testmuster generieren > TG18-QC (File > Generate Test Pattern > 

TG18-QC), um das Musterbild TG18-QC (unten abgebildet) zu öffnen. 
 

 
 
 
2. Führen Sie eine Sichtprüfung der folgenden Eigenschaften durch: 
 

a. Geometrische Verzerrung: Überprüfen Sie, dass die Ränder und Linien des 
Musters sichtbar und gerade sind und das Muster innerhalb des aktiven 
Bereichs des Anzeigegeräts zentriert ist. 

 
b. Allgemeine Bildqualität und Artefakte: Beurteilen Sie die Gesamterscheinung 

des Musters. Beachten Sie alle Unregelmäßigkeiten und Artefakte, 
insbesondere an Schwarz-Weiß- und Weiß-Schwarz-Übergängen. Beachten 
Sie, ob die Rampenbereiche ohne verzerrende Artefakte erscheinen. 
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c. Luminanz, Reflexion und Störsignale: Überprüfen, dass alle 16 Luminanz-
Patches gut sichtbar sind. Überprüfen Sie, dass die 5 % bis 95 % Luminanz-
Patches sichtbar sind. Beurteilen Sie das Aussehen von Buchstaben mit 
geringem Kontrast und bestätigen Sie die Sichtbarkeit der Ziele in den Ecken 
der Luminanz-Patches. 

 
d. Auflösung: Beurteilen Sie das Aussehen von Cx-Zielen in der Mitte oder in 

den Ecken des Musters und bewerten Sie es im Vergleich mit der Referenz. 
Die Ergebnisse sollten <5 für primäre und <7 für sekundäre Anzeigen 
betragen. Überprüfen Sie außerdem die Sichtbarkeit der Linienpaar-Muster 
bei Nyquist-Frequenz in der Mitte und in den Ecken des Musters.* 

 
 
 
 
 
 
 
 
 

Bei Fragen zum Konfigurieren der ClinicalExpress-Software 
wenden Sie sich bitte an den technischen Support von VIDAR: 

Telefon:  +1.800.471.SCAN (+1.800.471.7226) 

  +1.703.471.7070 außerhalb der USA 

E-Mail:  medtech@3dsystems.com 

 
 

                                                      
* Die Schritte 2a bis 2d wurden mit freundlicher Genehmigung nachgedruckt aus „New 
Developments in Display Quality Control“ von Ehsan Samei in Quality Assurance and 
Quality Control in the Digital Imaging Department, Eds. E. Siegel, B. Reiner, J. Carrino, 
SCAR Premier Series, Society for Computer Applications in Radiology, Great Falls, VA, 
2002, S. 71-82. 
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